                              LgmVisio program users guide.

This program was designed for hydrostatic and seismic sensors data processing.

The data for this program is produced  by special programs such as 

Lgm.exe, Girder.exe and Lgm_Tev.exe.

                                        Program setup

  Distribution kit consists of  3 files:

     LgmVisio.001

     LgmVisio.002

     Setup.exe

  Run Setup.exe and program will be installed in selected directory.

  For the first setup that’s enough.

  If you will to restore your configuration you must have saved folder “Sets”.

  Copy this folder files from place where you save it to the LgmVisio folder.

                                      Data file types

  *.hdr - text header. Used only for targeting to all other data files.

         You must select an "*.hdr" file for loading. If you have only data

          file and no hdr file - rename any file to data_file_name.hdr and place

          to the same directory. 

  *.lev - level, temperature, pressure, roll and pitch angles data

  *.aaa - power spectral density integrals of seismic data

  *.psd - power spectral density data

  *.raw - raw seismic data. Raw data is very big and LGM program as a rule used this files as         

               temporary storage and overwrite this file many times during measurement process.

  *.tdf - test device movement.

  *.rsa – sample file

Right click on button/control will cause help screen appear.

If not, on panel must be string "Right click here for help".

For all questions mail to "M.N.Kondaurov@inp.nsk.su".

                                      Load data files panel 

  Press “Load Data Files” button on main panel (fig.2) to open "Load Data files" panel(fig.1).

You must select an "*.hdr" file for loading. If you have only data file and no hdr file - rename any file to data_file_name.hdr and place to the same directory. Program works with many data files extension and this manner of data file selection is more suitable. Hdr file doesn't contain important information, but it is always present. Other files can be absent in current data set.

“Load Data Files” panel has only one button – “Select Data Files”.

All other controls only indicates presence of different kinds of data files, start and stop time,  working level and seismic sensors. You can see 5 leds for indicate data file presence. If led is green file of this type is found.

‘Tbase” - base temperature for fogale T sensors, usually 20 C.

“DAS frequency” – measurements  frequency for seismic data. 

“Sas accum. Count” - averaging of level data.

“Sas level time” - time between levels measurements.

“Hours” - time length in hours of data files (exclude raw seismic).

“Start and Stop” - measurements starts and stops. If program terminated or

data file is in processing by data acquisition program  - no stop data available.

In the right corner you see three columns of numerics – HL sensor On/Off  indicators.

This is HLS logical numbers and its state in this data file.

If numeric is hide  - this sensor is turned off by user.

If frame of numeric is yellow - fogale sensor is on.

If frame is green -  SAS sensor is on.

Warning: the values to this panel are moved from different types  of data files. So, if one or more data file is absent,  you can see strange values in some numeric.
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                           Fig.1 – Load Data Files panel

The little leds near sensor indicates roll and pitch angle sensors presence. 

[image: image2.png]=10l

Renove Settings ‘ Renove Level Samples

Remove Seismic Samples

Right Click here for Help

Level A
w31
visualization ny 32

ASCIT x.dat from file
Coefficients
Concatenate LevelaAan AdA fle

Time Select LeveltAan files

New Point Frequency for level File

Load Data Files ‘

Seismics
e 33
visualization
ny 32

PSD - pover spectral density
AAA - pover spectral density integrals
A - fron 0 to 2 Hz,
B-From 2 to 20 Hz
C-From 20 Hz





                     Fig.2 – main panel

                                           Main Panel Controls

 “Remove Settings Button” on main panel.

  Program saves all your selected values in special file "defaults.set", so you always return to you previous state. You can save current state in file with selected name (in visualization mode).

When you press this button, you can delete (remove) selected settings files.

  “Remove Sample” button.

  Program can save all your settings with file names as "Sample", so you must select only sample file name when wish to look it. When you press this button, you can delete (remove) selected sample files. Here is Level Samples.

  “Remove Seismic Sample” button.

  Program can save all your settings with file names as "Sample",

so you must select only sample file name when wish to look it.

When you press this button, you can delete (remove) selected sample files.

“Level Visualization” button on main panel.

Press this button for level & AAA (Power spectral Density Integrals) data visualization. Number of plots you can select on two numeric controls on the right of this button. See below for details.

  “ASCII *.dat from file” button on main panel. 

  Creates text file (*.dat) from binary data files.

“Coefficients” button.

Here you can set coefficients for Fogale sensors, if in data storing program you select save data as "Raw volts".  This coefficients apply to level data in next manner:

   v - data from file.

   level=a0+a1*v+a2*v*v+a3*v*v*v;

This usually apply to Fogale sensors if data in file is in volts.

For SAS sensors a1=1, all other are 0.

The column of controls "HLS" helps you to set coefficients for two types of Fogale sensors

 (“HLS 2.5” and “HLS 5.0”) and for SAS sensors. Now “mkm” is equal to SAS, but in future it may be changed. Columns on the right bottom show you the type of sensor from level data file. 

This coefficients are stored in defaults.set file only. If you see strange graphs, go to this panel, if coefficients for SAS is as for Fogale - you can see strange picture!

When you set all coefficients , press "Calculate data" button.

  “Concatenate Level&AAA” button on main panel.

If you have two or more data files with same settings and not far from each other in time, you can concatenate this files in one continuous file.

Only Level & AAA (Power spectral Density Integrals) files can be concatenated.

“Time select Level&AAA” button on main panel.

Press this button to select time interval for new data file have being created. In other words, you cut out a piece of data file in new data file.

 “New points frequency for Level file” button on main panel.

Press this button to select new point frequency for data file have being created from selected file. Data points in old file are averaged with selected value and new shorter file have been created.

 “Level Visualization” button on main panel.

Press this button for level & AAA (Power spectral Density Integrals) data visualization. Number of plots you can select on two numeric controls  on the right of this button. See below for details.

 “Seismic Visualization” button on main panel.

 Press this button for seismic data visualization. Number of plots you can select on two numeric controls on the right of this button. See below for detail.




HLS data Visualization

 When you press “Level Visualization” button on main panel you can see picture from fig.3.

If you click Right Mouse button on the central part of the plot, you can see

“Visualization parameters panel” (fig.4).  

If you click Right Mouse button near the X-axis  of the plot, you can see 

“X-axis parameters panel” (fig.5).  

If you click Right Mouse button near the Y-axis  of the plot, you can see 

“Y-axis parameters panel” (fig.6).  

If you click Left Mouse button on the central part of the plot the program redraw data in all plots. 
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                         Fig.3 Visualization window for HLS data.

  This panel used to draw data in a graphs form. First you must select number of plots on main panel. Nx and Ny controls allow you to select number of plots on X and Y directions. Total number of plots is limited to 9. Then press "Visualization" button on main panel. You see panel with plots. Left Click in the middle of any plot will cause data draw.

Right Click in the middle of any plot will cause parameters  panel appearance. Most settings is apply only to graph from which you Right Clicked. Graph number appears in the panel title as "Window n" from 1 to 9. 

When work with diffusion don’t forget to check distance between sensors on “Options” menu. Controls on parameters window panel:

Number of plots - set amount of curves on the graph from 0 to 15.

Plot N          - set number of curve you setting. 

   Next controls applies only to specified curve:

     Channels  - logical numbers of HLS.

     Data type – see below.

     Right click on this control for full list.

X button - X axis settings panel appear.

Y button - Y axis settings panel appear.

X,Y panels also can be displayed by Right Click in the graph

labels area, near the left bound for Y and near the bottom bound to X.

Y settings panel controls:

Log/Linear - logarithmic or linear scale

Labels On/Off - axis label appearance control

Format float - floating point labels.

Format Scientific - x.yE-nn form labels.

Auto On  - auto scale on Y.

Auto OFF - manual scale on Y. Next controls available in this case:

Two numeric controls in up and down of the panel allow you to select Y axis boundaries.

The scale between this controls allow you to select scale by   moving two pointers.

X settings panel controls:

Log/Linear - logarithmic or linear scale

Labels On/Off - axis label appearance control

Format float - floating point labels.

Format Scientific - x.yE-nn form labels.

Auto On  - auto scale on X

Auto OFF - manual scale on x. Next controls available in this case:

Two numeric controls in left and right of the panel allow you  to select X axis boundaries.

The scale between this controls allow you to select scale by  moving two pointers.

Time units select control switch X labels to minutes, hours and days.  

Seconds may not be applied if average count is too big.

                                        Visualization parameters panel.
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                                            Fig.4 Visualization parameters panel.

    “Channels” controls 

There are three controls for channel. Left control is for selection sensor number for one-channel calculation or for the first sensor number for two-channel calculation. 

Middle control is for selection second sensor number for two-channel calculation. 

The right control is for the some kinds of data processing where you need to select special temperature channel.

    “Number of plots” control

Select number of curves on one graph (window)

    “Plot N” control

Select current curve on the plot. The color of curve, channels 

and data type plotted applied to current curve only.

    “Subtr.Linear Regression” check box

Subtracts linear regression from level data.

If checked  you can see only local data change. 

   “Relative levels” check box

Relative or absolute level data selection

If checked levels are relative. 

“ReDraw” check box.

If checked, program redraw  plot after you change

even one parameter of plot.

   “Coherens/Cross Spectrum” button      

Select Cross Spectrum or  Coherence instead “Cross Spectrum” data type.

If "Coherence" is selected, Real Valued FFT transform is calculated for both data

arrays and L1im/L1real and L2im/L2real are stored. Next calculations:

sp_xy2=SQRT((L1i^2+L1r^2)*(L2i^2+L2r^2)

Coherence real=(L1r*L2r+L1i*L2i)/sp_xy2;

Coherence im  =(L1i*L2r-L1r*L2i)/sp_xy2;

   “Diffusion %” button      
Diffusion calculations criterion:

 <Diffusion %> no dL(dT) data averaging, % - bad data persentage

 <Diffusion 2> no dL(dT) data averaging, % - bad data N

 <Diffusion 3> dL(dT) data averaging on dT interval, % - bad data N

Numeric control near this button is  Diffusion calculations bad data criterion.

If <Diffusion %> - here you set persentage of bad data for deleting.

Bad means maximum absolute value in array dL(dT).

If <Diffusion 2 or 3> - here you set N for bad data deleting.

If   (dL(dT))^2 > N^2*ms    than delete data point, ”ms” – mean square

dL(t) = Li(t)-Lk(t)

dL(dT) = dL(t+dT)-dL(t)

ms = summ(dL(dT)^2)/npoints

When work with diffusion don’t forget to check distance between sensors on “Options” menu.

   “FFT Filter” check box      

If  checked  FFT filter is apply to level data.

   “FFT Filter Set” button      

FFT filter settings if “Upper/Lower” box checked:

  Lower cutoff % - percent of lower harmonics to be deleted

  Upper cutoff % - percent of upper harmonics to be deleted

FFT filter settings if “F1/F2” box checked:

  F1 milli Hertz -  lower frequency

  F2 milli Hertz -  upper frequency

   “Diffusion averaging” check box

If checked, diffusion is calculated as mean diffusion on selected time interval in all data set.

If not checked, diffusion is calculated as diffusion on selected time without averaging.

When work with diffusion don’t forget to check distance between sensors on “Options” menu.
   “dL standart” button      

Level difference criterion.

If “Standard” than   dL(t) = Lk(t)- Li(t) , t-time

If “not standard” than  dL(t) = (Lk(t)-Lk(0)) - (Li(t)-Li(0))

   “T comp.” control      

Select T compensation kind

  T comp OFF -  no T compensation

  Ti comp ON  - Ti used for Li compensation

  Tm comp ON  - mean T used for T compensation

   “X and Y”  buttons

X-axis and Y-axis parameters. See below.      

                             “Data type” control      

 Selects data type for drawing.

1.Level, Temperature, Pressure, Level Difference, Temperature Difference,

   roll and pitch  angles.

2.Level Spectrum & T Spectrum

  Data array is windowed by selected window and Spectrum (power spectrum) is calculated.

  If "Time interval" selected(!=0),averaging on this interval is produced.

  Then normalization is produced: array elements multiplied on (array size/frequency(hz)).

3.Level CrossSpectrum & T CrossSpectrum
  Data arrays is windowed by selected window and then if "CrossSpectrum" selected,

  CrossSpectrum (correlation) of two data arrays is calculated.

  If "Coherence" is selected, Real Valued FFT transform is calculated for both data

  arrays and L1imaginary/L1real and L2im/L2real are stored. Next calculations:

   sp_xy2=SQRT((L1i^2+L1r^2)*(L2i^2+L2r^2)

  Coherence real=(L1r*L2r+L1i*L2i)/sp_xy2;

  Coherence im  =(L1i*L2r-L1r*L2i)/sp_xy2;

  If "Time interval" selected(!=0),averaging on this interval is produced.

  Module of Cross Spectrum or Coherence is drawing: sqrt(Re^2+Im^2)

4.L-T CrossSpectrum - as 3 for Level & Temperature arrays

5.L-Tm Cross spectrum - as 3 for Level & mean T arrays

6.Lm-Tm CrossSpectrum - ad 3 for mean Level & mean T arrays

7.Lev.Diff.Power - as Spectrum, but for Level difference

8.Lm-Ln&Ti CrossSpectrum
  Lm-Ln difference & Ti Cross Spectrum or Coherence (like 3)

9.T Diff. Power - as Spectrum for T difference

10.Mean Level,Mean T
11.Diffusion

   If "diffusion averaging" checked & "time interval"!=0 then diffusion averaging !

   "Diffusion %,1,2" button & diffusion % numeric are involved !

   Level difference is calculated and then selected diffusion is calculated.

   Diffusion % & %=0 normal diffusion

   Diffusion % & %=xx normal diffusion, but in sum included only values not big then

                      xx % of meanroot value

   Diffusion 2 & Diffusion 3 - ask V.Shiltcev

When work with diffusion don’t forget to check distance between sensors on “Options” menu.

12.Diffus.Tcomp(dL-dT) 

   Level difference (no T compensation) calculated

   T     difference calculated

   For Level difference with T compensation T difference is used.

   Diffusion (like in 11) is calculated.

13.L(no Tcorr)-L(T)

   Fogale sensors only: level without T correction minus data with T correction.

14.A - PSD 0-2Hz, B - PSD 2-20Hz C - PSD 20-...Hz
   Seismic data: Power Spectral density in integrals on selected interval.

15.Tcor  dL on dT

   Level difference (no Tcompensation) calculated

   T     difference calculated

   For Level difference with T compensation T difference is used.

16.S - Aver.Seismics - averaged seismic data

17.Double Diffusion
   Double Difference (p.18): Lx=Lk+Lg-Lm-Ln

   Then Diffusion as in 11 is calculated

When work with diffusion don’t forget to check distance between sensors on “Options” menu.

18.Double Difference

   4 Level channels selected:k,n,n.g

   Level Double Difference: Lx=Lk+Lg-Lm-Ln

19.D.Difference Power

   Power Spectrum (as in 2) for double Difference (as 18).

20.D.Differ&Ti CrossSp 
   Level Double Difference & Ti Cross Spectrum (as in 3)

   If  i = (N of sensors) then T mean used

21.SR - SR_k(t)=0.125 * summ(from n=0 to n=N sensors) L_n(t)*cos(2*pi*k*n/8)

22.SI - SI_k(t)=0.125 * summ(from n=0 to n=N sensors) L_n(t)*sin(2*pi*k*n/8)

23.Spectral Diffusion
   SR (as 21) is calculated, Diffusion Dsr (as 11) is calculated

   SI (as 22) is calculated, Diffusion Dsi (as 11) is calculated

   Spectral Diffusion(i) = Dsr(i)+Dsi(i)

When work with diffusion don’t forget to check distance between sensors on “Options” menu.

24.Stability Graph -  D = L(maxn)-Lmean(maxn), where maxn - max i

                      S(i) = L(i)-Lmean(i)-D

25.Plane Stability -   3 levels as plane basis,plots

                       4-th level deviation from basis plane

26.Test Device Movement
  Test device movement used it's own time scale, the last point on the graph

  is the last movement only and can't be scaled as all other's graphs x-scales. 

    “Grid color”, “Curve color”,”Back color” controls on parameters panel

Graph  grid color

Graph background  color

Current (Plot N) curve color

    “Plot” control on parameters panel

Curve type selection: thin line, connected points, ets.

Left Click on this control show you all available plot types. 

    “Line” control on parameters panel

Plot line type selection: solid, dash, dot, ets.

Left Click on this control show you all available types. 

    “Window” control on parameters panel

Select Window Type for spectral graphs. Almost every application requires you to use finite length signals. This requires that continuous signals be truncated, using a process called windowing.

    “A” button on parameters panel

Diffusion calculations button.

Diffusion calculates from levels data using temperature  compensation from this panel

When work with diffusion don’t forget to check distance between sensors on “Options” menu.

    “AdT” button on parameters panel

Diffusion calculates from levels using delta L on delta Temperature compensation.

When work with diffusion don’t forget to check distance between sensors on “Options” menu.

    “Subtract initial value“ button on parameters panel

By pressing this button  you select "subtract initial value" mode for all level data. The first value of the level array is subtracted  from all other data points. This is applied to all graph types includes level data.

After starting program mode is always no subtract.

    “Time interval (hour)“ control on parameters panel

Select time interval for drawing , if interval equal 0 - all data file.

For spectral and diffusion means averaging interval. 

All spectral graphs draws as mean graph on this time interval in all data file.

    “Next interval “ button on parameters panel

Drawing the next time interval.

    “Previous interval “ button on parameters panel

Drawing the previous time interval

    “RC filter tau(counts)“ control on parameters panel

RC filter is applied to level data if you select value, not equal 1.

 Filtering: 

   You select N for RC tau.

   Program sum N points of data, divide it on N. 

   This is new value for level(N).

   Then first point are removed from sum and next adds.

   This is new value for level(N+1) and so on.

   first N-1 points not changed.

   RC filter count is not saved/restored. 

                       Visualization parameters panel menu bar.

For Menu Bar help click on “Help->Menu Help” string and then click on needed menu string.

Click on <Menu Help> string again to return to working regime.

  
“File” menu

“Print Single Plot” – prints on printer a single plot (current window on panel)

“Print All” – prints  on printer all plots, all graphics panel.

“Create GIF” -  creates GIF file from graphics panel.

“Save Settings” - saves all program parameters to file

“Load Settings” - loads all program parameters from file and draw plots with new parameters.

“Save Sample” - saves all program parameters and data file name to file

“Load Sample” - Restores all program parameters and data file name from file and draw plots  

                             from this data file with this parameters

“Create Single Ascii” - creates ASCII *.dat file from current plot

“Create All Ascii” - creates ASCII *.dat file from all plots on panel in form:

          X  y0  y1  y2 ....

          X  y0  y1  y2 ....

          X  y0  y1  y2 ....

If you have different kinds of X axis, ASCII file can't be created.

         “Options” menu

“Cursor Off”  - checked/unchecked menu string. When unchecked two cursors appeared on the  

                           plot. You can move it and do some actions. See below.

“Show time by cursor”  - checked/unchecked menu string. When checked and cursors on you  

                                            can see real time of blue cursor below the X axis.

“Bounds by cursors”  - checked/unchecked menu string. When checked and cursors on you  can 

                                        select bounds of drawing by cursors (or markers). In X-axis and in

                                       Y-axis parameters panel there are “Bounds by markers” buttons and 



                 “Draw by bounds” menu string in “Options” menu.  After using this 

                                         options auto scaling  on X and Y axis is OFF!

“Draw by bounds” – set bounds of drawing using cursors position and draws plot.  After using 

                                    this options auto scaling  on X and Y axis is OFF!

“Select font” - selects font for X and Y axis names.

“Double Diff.Channels” - select channels for Double Diffusion. Double Diffusion calculates 

                                           from four channels, so you must select its here.

                                          When work with diffusion don’t forget to check distance between 

                                           sensors on “Options” menu.

 “Plane stability parameters” - parameters for plane stability calculation.

   Base channel 1 - sensor number for first base channel.

   Base channel 2 - sensor number for 2-nd  base channel.

   Base channel 3 - sensor number for 3-rd  base channel.

   Channel 4:     - sensor number for plane stability calculation.

   Square side (meters) - all sensors must be in the angles of square.

   Here you set side length of this square.

“Window 0 to all” - You can move parameters you selected for plot 1 (window 1 in parameters 

                                    panel) to all other  plots.

“Markers” - you can place color text string on current plot. 

“L*Coefficient(Tbase,T)” - if this menu string  is checked, level data for Fogale sensors

                                               is calculated using T data and T base.

“Sensor distance for Diffusion” - here you must select distance between sensors  for Diffusion 

                                                        calculation. This information saved in settings file.

         “Plot” menu

“Alpha” - draws plot of  Alpha:

  You must select interval (<Time interval> control)

  On each interval realized next routine:

  1) Mean level Lm and mean temperature Tm are calculated

  2) Tx=sum on interval of (Li-Lm)*(Ti-Tm) is calculated

      T2=sum on interval of (Ti-Tm)*(Ti-Tm) is calculated

  3) alfa(k)=Tx/T2,  where k is number of interval

  4) alfa(k) plot is drawn.

“Histogram of  distribution Lm-Ln” - draws  Histogram of  distribution Lm-Ln.

          X-axis parameters panel.
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                                        Fig.5 X-axis  parameters panel.

Controls on X-axis parameters panel

  “Left (right) bound (numeric) selector“ 
When not auto scaling  (Auto OFF), are used for  X maximum and X minimum selection.

  “Labels” switch

On/Off  X-axis labels  drawing.

   “Float/Scientific” switch

Float point (3.14) or scientific (0.31e+1) labels on X axis

  “Log/Linear” switch

Logarithmic or linear scale on X axis selected

  “Divisions” numeric

Number of divisions on X-axis. If 0  auto selection.

  “Set max&min” button

When not auto scaling  press here to auto select left and right bounds as minimum and maxim value on axis.

  “Bounds by markers” button

“Bounds by cursors”  menu string in “Options” menu must bee checked 

 “Draw by bounds” menu string in “Options” menu must be checked.

 Set bounds of drawing using cursors position and draws plot.  After using 

 this options auto scaling  on X and Y axis is OFF!

  “Scale Up/Down” buttons

When not auto scale, press here to scale up or down 

  “X-axis units” selector

Here you can select units of X axis. For frequency units are always milli Hertz.

You can’t select seconds if point frequency on time axis is more than 1 seconds.

  “Auto OFF/ON” button

Axis auto scaling  On/Off.

  “To All” button

All selected Y axis parameters are moved to all other plots.

                                              Y-axis parameters panel.
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                                        Fig.6 Y-axis  parameters panel.

Controls on Y-axis parameters panel

  “Upper (lower) bound (numeric) selector“ 
When not auto scaling  (Auto OFF), are used for  Y maximum and Y minimum selection.

  “Labels” switch

On/Off  Y-axis labels  drawing.

   “Float/Scientific” switch

Float point (3.14) or scientific (0.31e+1) labels on Y axis

  “Log/Linear” switch

Logarithmic or linear scale on Y axis selected

  “Inner Markers” switch

Sometimes useful for better viewing with logarithmic scale.

  “Divisions” numeric

Number of divisions on Y-axis. If 0  auto selection.

  “Set max&min” button

When not auto scaling  press here to auto select left and right bounds as minimum and maxim value on axis.

  “By markers” button

“Bounds by cursors”  menu string in “Options” menu must bee checked 

 “Draw by bounds” menu string in “Options” menu must be checked.

 Set bounds of drawing using cursors position and draws plot.  After using 

 this options auto scaling  on X and Y axis is OFF!

  “Scale Up/Down” buttons

When not auto scale, press here to scale up or down 

  “Auto OFF/ON” button

Axis auto scaling  On/Off.

  “To All” button

All selected Y axis parameters are moved to all other plots.




Seismic data Visualization

 When you press “Seismic Visualization” button on main panel you can see picture from fig.7.

Seismic data is not contiguous array of data. It is a number of samples. Time length of sample depends of seismic measurement frequency. Each sample has Sample time – time when sample starts to measured.

If you click Right Mouse button on the central part of the plot, you can see

“Visualization parameters panel” (fig.8).  

If you click Right Mouse button near the X-axis  of the plot, you can see 

“X-axis parameters panel” (fig.9).  

If you click Right Mouse button near the Y-axis  of the plot, you can see 

“Y-axis parameters panel” (fig.10).  
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                                        Fig.7 Seismic data visualization

If you click Left Mouse button on the central part of the plot the program redraw data in all plots. 

  This panel used to draw data in a graphs form. First you must select number of plots on main panel. Nx and Ny controls allow you to select number of plots on X and Y directions. Total number of plots is limited to 9. Then press "Visualization" button on main panel. You see panel with plots. Left Click in the middle of any plot will cause data draw.

Right Click in the middle of any plot will cause parameters  panel appearance. Most settings is apply only to graph from which you Right Clicked. Graph number appears in the panel title as "Window n" from 1 to 9. 

Controls on parameters window panel:

Number of plots - set amount of curves on the graph from 0 to 15.

Plot N          - set number of curve you setting. 

   Next controls applies only to specified curve:

     Channels  -  numbers of seismic channels.

     Data type – see below.

     Right click on this control for full list.

X button - X axis settings panel appear.

Y button - Y axis settings panel appear.

X,Y panels also can be displayed by Right Click in the graph

labels area, near the left bound for Y and near the bottom bound to X.

Y settings panel controls:

Log/Linear - logarithmic or linear scale

Labels On/Off - axis label appearance control

Format float - floating point labels.

Format Scientific - x.yE-nn form labels.

Auto On  - auto scale on Y.

Auto OFF - manual scale on Y. Next controls available in this case:

Two numeric controls in up and down of the panel allow you to select Y axis boundaries.

The scale between this controls allow you to select scale by   moving two pointers.

X settings panel controls:

Log/Linear - logarithmic or linear scale

Labels On/Off - axis label appearance control

Format float - floating point labels.

Format Scientific - x.yE-nn form labels.

Auto On  - auto scale on X

Auto OFF - manual scale on x. Next controls available in this case:

Two numeric controls in left and right of the panel allow you  to select X axis boundaries.

The scale between this controls allow you to select scale by  moving two pointers.
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   Fig.8 Visualization parameters

    “Channels” controls 

There are two controls for channel. Left control is for selection sensor number for one-channel calculation or for the first sensor number for two-channel calculation. 

Right control is for selection second sensor number for two-channel calculation. 

    “Number of plots” control

Select number of curves on one graph (window)

    “Plot N” control

Select current curve on the plot. The color of curve, channels 

and data type plotted applied to current curve only.

   “X and Y”  buttons

X-axis and Y-axis parameters. See below.      

  “Data type” control      

 Selects data type for drawing.

1.Raw Seismic

2.Seismic PSD – power spectral density

3.XLR – raw seismic integral (linear regression subtracted)

    “Grid color”, “Curve color”,”Back color” controls on parameters panel

Graph  grid color

Graph background  color

Current (Plot N) curve color

    “Plot” control on parameters panel

Curve type selection: thin line, connected points, ets.

Left Click on this control show you all available plot types. 

    “Line” control on parameters panel

Plot line type selection: solid, dash, dot, ets.

Left Click on this control show you all available types. 

    “Next sample “ button on parameters panel

Drawing the next sample.

    “Previous sample “ button on parameters panel

Drawing the previous sample.

“Print” button

Prints  on printer all plots, all graphics panel.

“GIF” button

Creates GIF file from graphics panel.

  “Search for sample time“ control on parameters panel

Finds sample with selected sample time.

  “PSD:”  string

Shows the PSD sample time.

  “RAW:”  string

Shows the Raw seismic sample time.

  “ASCII” button

Creates ASCII *.dat file from current plot

“Raw Sample Time(sec)”  control

Allows user to select raw seismic sample time. If you select time less than real sample time program shows you only part of sample. If  you select time greater  than real sample time program concatenates needed number of samples and shows you as a one sample. 

   “Save Set”  button

saves all program parameters to file.

   “Load Set”  button

Loads all program parameters from file and draw plots with new parameters.

“Save Sample”  button

Saves all program parameters and data file name to file

 “Load Sample” button

Restores all program parameters and data file name from file and draw plots  

from this data file with this parameters
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   Fig.9 X-axis parameters

  “Left (right) bound (numeric) selector“ 
When not auto scaling  (Auto OFF), are used for  X maximum and X minimum selection.

  “Labels” switch

On/Off  X-axis labels  drawing.

   “Float/Scientific” switch

Float point (3.14) or scientific (0.31e+1) labels on X axis

  “Log/Linear” switch

Logarithmic or linear scale on X axis selected

  “Scale Up/Down” buttons

When not auto scale, press here to scale up or down 

  “Auto OFF/ON” button

Axis auto scaling  On/Off.

  “To All” button

All selected Y axis parameters are moved to all other plots.

  “Font” button

Select font for X and Y axis names.
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   Fig.10 Y-axis parameters

  “Upper (lower) bound (numeric) selector“ 
When not auto scaling  (Auto OFF), are used for  Y maximum and Y minimum selection.

  “Labels” switch

On/Off  Y-axis labels  drawing.

   “Float/Scientific” switch

Float point (3.14) or scientific (0.31e+1) labels on Y axis

  “Log/Linear” switch

Logarithmic or linear scale on Y axis selected

  “Divisions” numeric

Number of divisions on Y-axis. If 0  auto selection.

  “Set max&min” button

When not auto scaling  press here to auto select left and right bounds as minimum and maxim value on axis.

  “Scale Up/Down” buttons

When not auto scale, press here to scale up or down 

  “Auto OFF/ON” button

Axis auto scaling  On/Off.

  “To All” button

All selected Y axis parameters are moved to all other plots.

If you have any  questions mail to "M.N.Kondaurov@inp.nsk.su".

November 14, 2003.
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